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PC - Mac - Tablet - Smartphone - Embedded device

WiseMo Guest Module WiseMo Host Module
for example on your PC on your device

Internet

i

Premises based

WiseMo develops software for remote control between computers and devices, for example
between PCs, Servers, Mac computers, Smartphones, Tablets, and other handheld or un-attended
devices. Using WiseMo software you have a powerful set of remote control and management
features available to increase your efficiency — saving you time and money.

Guest & Host modules

The WiseMo Guest module runs on the computer or device from where you want to access and
take remote control of other computers and devices.

The WiseMo Host module runs on computers and devices to prepare them for access by users with
a Guest module.

Cloud & On-premises connectivity:

Connection between the Guest module and the Host module is either established via WiseMo’s
myCloud connectivity over the Internet or directly using TCP/IP communication on a LAN/WAN
network managed by you.

For Cloud connectivity (WiseMo myCloud), your computer or device must be able to use the
Internet, for example via fixed line, Wi-Fi or mobile operator network (3G, 4G, etc.). This will allow
you to reach a computer or device wherever it may be and from wherever you are - as long as
there is Internet connectivity on both the Guest and Host computer.

By using TCP/IP directly between Guest and Host computer on your own network (e.g. your Wi-Fi,
LAN or WAN) you can avoid Internet traffic and possible data charges from your mobile operator.

The Windows Mobile / CE Host application

This guide provides information on how to install, configure, use and uninstall the Windows
Mobile/CE Host application — our Host module for use on Windows Mobile / Windows Compact
Embedded devices. The Host module prepares the device for efficient remote control from
computers and devices running a WiseMo Guest module.

IMPORTANT: This guide assumes that you have a WiseMo Guest module available on a computer
or device, ready to reach your Win Mobile/CE device, either via myCloud connectivity or directly
via TCP/IP. For information on how to setup a Guest module, please refer to the tutorials for such
module. Available documents can be found here: http://www.wisemo.com/support/documents/

WiseMo develops cloud based and premises based remote control software for use
‘ between computers and devices, e.g. between PCs, Servers, Mac, Smartphones,
\‘\\ \ Tablets, and other handheld or un-attended devices. Our cross platform solutions target
the commercial and industrial remote support and management (RSM) market.

For more information, see www.wisemo.com.
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1a. Installation of the Windows Mobile / CE Host application

The WiseMo Mobile Host application is installed on the remote target device.

Download the Host

You can get the Mobile Host installation file, a CAB file, from various sources, for example via the
Deploy tab in a WiseMo myCloud account (trial or paid) or via a download link from the email
supplied after a purchase or after requesting a free trial.

For download from WiseMo via the Deploy tab in your myCloud account, select the Mobile Host
link, which brings you to the download page (login from the browser on your device!, or login from
your PC). Notice you can deploy the download link, for example via email or SMS, to the target
device. When downloading via link from the myCloud Deploy tab, the Host will come pre-
configured for both myCloud connectivity and TCP/IP connectivity.

If you have a trial or delivery email from WiseMo, with a link or download button, simply click it to
go to the download page. The Host will come pre-configured for TCP/IP connectivity.

The download page contains multiple packages; select the correct package for your device for
compatibility with CPU and operating system. Each package comes as a single CAB file for direct
installation on the device or as part of an MSI installation package for installation via your PC.

You can download the CAB installation file directly to your device, or to your PC. If you have saved
the CAB file on a PC, the easiest way to copy it to the device is usually with Windows Explorer.

Downloading the MSI installation package to your PC will allow you to install not only the Host via
your PC, but will also install the Windows based Mobile Host Configuration Manager on your PC
(see description later in this document).

Windows CE Notice: A Host package for your type of Windows CE device may not be available
via your myCloud domain. Look instead for a package via the download links found in the email
received after purchase of perpetual licenses or request of a free trial. It is still possible to use
your myCloud domain for connectivity with internet enabled Windows CE devices, but you must
then manually configure such Host module (see chapter 4 on how to do this). If a package is not
found at all, please contact us at: support@wisemo.com We can perhaps build a special installation
package for your specific device.

Install the Host
Run the CAB file on the device to install the Host module, or run the MSI file to install via your PC.

Running the CAB file directly on the device may prompt for a license key, unless the CAB file was
deployed from a myCloud domain. IF the CAB file was deployed from a myCloud domain, make
sure the device has internet connectivity during installation, as it needs to communicate with the
myCloud domain to obtain its license to run.

When installing via a PC using the MSI installation package, make sure that ActiveSync/Mobile
Device Center is installed and connect the device physically to the PC with a USB cable prior to
running the MSI file. The installation package will install both the Host Configuration Manager and
the mobile device installation files on the PC.

PFEES S During the MSI installation you will be prompted for an installation path.

Instaling Host CAB . This is the path of the Configuration Manager program on the PC.
I 5 | wi
If a device is connected, the installer will copy the lw'EMD; ,
corresponding device CAB file to the device and @ ii L9
launch the installation. Check your device display |Peomest  Fase Redest
E to see if you need to carry out additional steps to ® )
complete the installation. Hstory m;;‘

IF the MSI file was deployed from a myCloud
domain, make sure the device has internet
connectivity during installation, as it need to

L- communicate with the myCloud domain to obtain

! older windows Mobile/CE devices may no longer have good Browser support. In such cases, log in to your
myCloud domain from your PC. Configuration to use a myCloud domain is best done by connecting your device
to your Windows PC and then using the Setup Wizard found in the WiseMo Host Configuration Manager.
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its license to run. Disconnect the device from the PC, when the screen on the device state so.

If the installation file did not come from a myCloud domain, you will during installation be
prompted to enter a license key.

When installed, the Host application will initialize communication and wait for a remote user
(Guest) to connect to it.

The Host must be licensed
In order to run, the Host must be licensed.

A Host can be licensed via applying a license key, either a purchased perpetual key or a trial
license key. The Host can also be licensed via a myCloud domain, in which case a license key
normally is supplied automatically. Check the About screen to verify the Host has a license key.
For more information about licensing, please refer to section 5 later in this document.

Default settings
The application is installed with default configuration settings, if not deployed with a customized

configuration file. As default, the Host will load when the device is switched on, and it will initialize
itself for communication when it is loaded. If there is no password protection pre-defined, the Host
application will on first run prompt for a Guest Authentication

password. This is the password that a remote user of the %% | WiseMo Host
Guest module, e.g. from a PC, will have to enter before being ; o
allowed to access and control the device. It is highly Specihy e GUestiadthenticstiongisssiord

recommended that you define a password that only is known [ |
to those who should remotely access the device. When a
remote Guest user is permitted access, the default security [[] Don't prompt next time
settings allow the use of all features available. You can apply
more restrictive authentication and authorization features by
using the Host Configuration Manager to modify the default settings (please refer to section 4.
Configuration Manager).

Ready for remote control
Select the Host on the device to verify its status.

%5 | WiseMo Host

When the Host is ready for a Guest to connect to it, the “Light .U/‘ ii 9’:
bulb” icon on the Home screen will show “Running”. :

Running Pause Request
Select the Info button and verify that the Host is on-line in . Help
your myCloud domain, if it has been setup for myCloud Q’) i)
communication. The Info screen also shows if the Host can be ¥
reached via UDP, TCP or both. Verify that a valid IP address is History Info

shown.

Addressing a Host from a Guest module

Please notice the IP address and the Host ID (Symbol90 on 4a Home
the screen shot). Both are shown on the Status screen. This [ svmbolso
are important ID’s a Guest user may use to address or identify | sypeoL MOoOooK
a Host. The Host ID must be kept unique. = Language: ENU
) ) @ 10.247.0.170
As default, the Host ID is the “device / computer name” as wpuListening profiles: TCP, UDP
defined on the device. You can set the Host ID value to your  myCloud "Wisema Dema Internal” online
preference via the Host Configuration Manager. You can also

modify the device name directly on the device, e.g. via settings/systems/about/Device ID.

In the myCloud list of Hosts, the “user name” field will show the "Owner” information, if defined on
the device, else it shows the “device / computer name” if available. Otherwise it will show the
“System model”.

The “System model” (SYMBOL MC9090K) is also used by the Guest module to download the Skin
file (picture of the device) from WiseMo’s Skin server, or from the local Guest computer or local
server, if you have placed the skin file here, for example if the Guest computer does not have
Internet access.
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1b. Host configuration
The Windows Mobile / CE Host configuration settings are stored in a Host.xml file. These settings

can easily be changed via the Host Configuration Manager running on a Windows PC (please refer
to section 4. Configuration Manager).

Examples of typical settings you may modify, using the Host Configuration Manager:

Program Options

Start Host at boot: The host app will load when the device is started.

Listen for incoming connections at Host Start: The host service initializes communication when it is
started and enters running state, ready to be accessed and controlled.

Host naming

The Host ID can be used by a Guest user to identify and reach the Host device. As default, the
Host ID will be the device name / computer name as defined on the device. You can define your
own choice of value as Host ID via using the Host Configuration Manager. When you have multiple
devices, it is important the Host ID is unique. IF the device name is the original generic device
name, the Host will add a random number to the device hame to make it unique - but only IF the
device name is the original generic device name (this condition to permit you to modify the device
name on the device, to your own liking, without the Host interfering). If special characters are part
of the Host ID, such should be allowed as part of file names by the OS on the Guest computer.

Guest Access Security

The Host has advanced authentication and authorization features, governing who may do what.
This is configured by selecting an authentication method (who) and a security role (what). As
default, the simpler Shared Password authentication method is used with a security role with full
permissions. This model permits a shared password and the use of Confirm Access. If a Guest user
is permitted access, all features are available (if supported by the Guest module). Use a more
advanced authentication method, if you for example want to require both a user ID and password
to authorize access. You can also use a more restrictive security role, to limit what is permitted.

Confirm Access: This feature will prompt the Host user to give permission prior to a Guest user
getting access. This is a strong security feature when a user is present at the device, but do not
use it in situations where you need to access un-attended devices.

Encryption

The Host offers you very high level encryption and protection against spying on and tampering
with the data stream (end-to-end encryption). The Host dictates ultimately which level of
protection is used. If different levels are permitted by the Host settings, the Guest user has the
option to decide its preferred encryption level. Especially when working over the Internet,
encryption is recommended, as you do not know which computers the data stream pass through.

Communication Profiles
Defines communication settings for various connection methods, and is mostly for skilled users.

For TCP/IP profiles, you can for example configure port settings.

For myCloud profiles, you may want to logon to a myCloud domain or change to another domain.
It is however strongly recommended that you use the Host Configuration Manager Wizard for this,
instead of directly modifying the myCloud communication profile(s).

Log Setup
Here you can enable logging of events, define the file to where the log should be written and
customize which events to log.

1c. Host features

The Host module prepares a Windows Mobile/CE device to be remotely reached by WiseMo Guest
users, and provides a number of features and functions that greatly enhance the benefits and
value. This irrespective of whether your purpose is to remotely work on the device as if you had it
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in front of you, or it is to provide remote support and assistance to troubled users, or perhaps to
remotely perform system management tasks on the device, like ending or starting tasks and
processes, or to transfer files and directories between the Windows Mobile/CE device and your PC.

The WiseMo Host is developed for use in both un-attended situations and in situations where there
is a user present at the device. For un-attended situations, you will want to have the app ready to
respond, when you have a need to access it remotely. If a user is present, you may want the user
to activate the program just prior to remote access, for example for security reasons, or to save
on battery and other resources.

Subject to being supported by the Guest module used, the Host provides for Remote Desktop
Control (remote view and control, including control of most device buttons), Remote clipboard
transfer, File Transfer, Hardware / Software inventory collection, Chat dialog, Remote execution of
apps, Receipt of messages from Guest users, and more. It also allows for multiple Guest users to
connect simultaneously to the same device.

Typically, the Host program is not used much by the device user, but prepares the device for
remote control by a remote Guest user, for example support staff, who, when permitted, remotely
can view the screen of the device and enter keystrokes / mouse input, plus perform other support
and management actions supported by the Guest / Host module. Some features that the device
user may benefit from knowing are listed below.

Home screen
The home screen shows the Host status, for example that it is running, or paused and whether a
remote Guest user is connected to the device or not. It offers a humber of buttons, and a menu.

Menu
Menu options include Restart or completely exit of the Host program. WiseMo|
It is also possible to define whether the Host automatically should load ) ii e
when the device is booted up. There is access to the About screen, o =

. . . . . . Disconnect Pause Request
which shows program version and license information. There is also a Help
Support Log menu item, which creates a troubleshooting log: & i)

\WsmHostWMCE.log file which is good to include if you need to report History Im’é

a problem to WiseMo.

Buttons
Disconnect Allows the Host user to disconnect the session with a
Guest. When no user is connected, it will show the

Support Log
v Load at boot

Host status, for example “Running” indicating the Host about..
is ready. Exit
Menu
Run/Pause Pause the Host or start it if paused.
Info The Info screen shows communication info, such as detected IP addresses and the

status when prepared for myCloud communication. It also lists the Host ID, which
a Guest user may use to identify / connect to the Host,
and the more generic Device ID is also shown.

& symbal-co0o0
e SYMBOL MC9090K

Help Request The Help Request screen is provided as backwards

compatibility to older PC Guest modules supporting this. | Larguage: EU
@ 10,240,125
. . . Listani files: UDR, TCP
History The history screen lists Guests connected / ‘3;;32‘33 oMo Do oniine

disconnected, with date and time stamp, since the Host
module was started. For more advanced logging
features, please use the logging features, which can be
configured via the Configuration Manager, described
later in this document.

Notice: Chat is possible between Guest and Host, initiated by the Guest
user. A screen pops up on the Host. The user on the Host device can
end the Chat session.

A Guest user may perform File Transfer, Hardware / Software Inventory and other actions on the
Host device, without interrupting the device user. When the Confirm Access security feature is
activated, a screen appears on the device, requesting the device user to accept or deny access
from a Guest user.
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2. Remote Control of the Host device
The module you use to access and remote control a distant device is called a Guest module.

You can remote control your device from a number of different platforms by using the applicable
WiseMo Guest module. For example, you can remote control from an Android device, an iOS
device (iPhone / iPad), from a Chrome browser on Mac, Linux or Windows PC, from an IE browser
or browsers supporting NPAPI components on Windows PCs. Finally you can use our most feature
rich Guest module, the Windows Remote Desktop Guest, installed on a Windows PC.

In this document we show an example of remote control from a Windows PC, via myCloud
(internet communication) and also an example of remote control directly via TCP/IP on a network
managed by you. For more info on the use of other Guest types, please see the documentation
relevant for each module here: http://www.wisemo.com/support/documents/

2a. Remote control from a Windows PC over the Internet (using WiseMo myCloud)

1. Follow the guide below to create a connection from a Windows Guest to a Host via the
Internet.

2. It is assumed that you have a myCloud domain and that you have deployed at least one
Windows Mobile/CE Host that is connected to this myCloud domain.

myCloud from WiseMo is a Cloud based service for easy remote control connectivity
between computers and devices, e.g. Mac, PCs, Servers, Smartphones, Tablets and other
handheld or un-attended devices. It also provides deployment options, including download
links and SMS deployment links, to help you easily deploy pre-configured Host and Guest
modules. If you do not already have a myCloud domain, sign up for a free trial or a paid
domain here: www.wisemo.com/mycloud

3. Please note that setting up a mobile Host to be available on the Internet may incur
mobile data charges from your provider. To avoid this, connect your device to an Internet
Wi-Fi connection without variable charges, when available.

4. Start the Windows Remote Desktop Guest module on your PC. You can get the Guest
module here: https://shop.wisemo.com/purchase/RSM/DownloadTrial.aspx or directly from
the Deploy tab in your myCloud account: www.wisemo.com/mycloud.

5. From the Guest console, select "myCloud Connections” from the Host Connectivity pane
found on the left. Also select the Connection tab.

WiseMo Remote Desktop Guest

Connection

Remote| File Chat Remote
Desktop Transfer Management

Inventory Message program Command ~

) B ey
TV
Collect  Send Run Execute Disconnect

Remote Control myCloud Domain

Hast Connectivity WiseMo Demo N S

Search =
3 myCloud cennections

Q All connections
I Phone book
f:] myCloud

- DEVOS-W7T - GT-NB020 - 5369 - SYMBOL!
[} Program options Test GT-N8020 Symbol
L} User interface

L/§ Session
B Start
) Remote Desktop
21 Mobile Skins
< File Transfer Layout

=

Remote Desktop

File Transfer

P 0=

.'-'\

Chat

Remote Management

Collect Inventory
Send Message

fixE <

3} File Transfer Options Run Program

@ Communication Profiles Execute Command 4

X

Disconnect

Connection Properties

Reset Connection Properties
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If the Guest module is logged into your myCloud domain, you will see available Hosts. If
you are not logged on, select the drop-down menu "myCloud Domain” and then “Log on”
or select the name of you domain, if already listed. Enter your myCloud User account
credentials (usually an email and a password). Now you will see the available Hosts.

Double click on a Host and a Remote Desktop session will as default start. Alternatively,
select a Host; click the button for the function you like, Remote Desktop, File Transfer,
Chat, Remote Management, Send message, Collect Inventory, Run program or Execute
command.

The first time you connect to a device, it will take some seconds
before the remote control screen is shown on your PC. This is
because the Guest is downloading a picture of the device, called a
Skin (you can read more about Skins later in this document).

B P X

A separate window is shown on your PC, with a menu at the top
and info about the connection at the bottom. The window shows
the device including live buttons and live screen. TIP: It is possible
to show the device without the window (use “Show as transparent
window”). You define this prior to connection, via the Connection
Properties settings. When a transparent window is used, point the
mouse on the device skin and right-click to access menu options.

Now you can remote control the device, that is, you can inject
keystrokes on the remote device, view how the screen of the
remote device changes and use the various other features, for
example file transfer, chat, remote clipboard transfer, etc.

10. The remote control session can be ended by closing the Skin
window, or pressing the disconnect button.

Live Remote
Control screen

Remote control from a Windows PC via your TCP/IP network

Follow this description to connect to a Host from a Windows PC that has the WiseMo
Remote Desktop Guest module installed. Make sure the Guest module is licensed for
TCP/IP connectivity (either logged on to a myCloud domain, or via a license key).

Make sure your device is setup to use a Wi-Fi network your PC can reach. Ensure that the
Host application has been started on your device.

From the Guest console’s “"Host Connectivity” pane, select “All Connections”, then enter
the IP address of the Host device into the Host ID field. Verify that *Communication
Profile” shows a TCP/IP profile, for example TCP/IP (TCP). Then click the “Connect” button.

NiseMo Remote Desktop Guest

j Home Connection Help style ~ @)

Chat

Session Action

Remote Control

Host Connectivity

Connect to

Host ID {Computer name or IP address): Communication Profile:
10,247.5.38 - ['rcpﬂp(rcp) -

- myCloud connections
’ E All connections
5 Phone book

=

/‘/‘.
[ Connect l

o~
Configuration ‘@ Connection Properties |

] Ig Program options

[ I O,

You can find the Host "s IP address by opening the Host module on the Windows Mobile/CE
device. The IP address is shown in the Host “s Info screen.
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3. The first time you connect to the device, it will take some seconds before the remote
control screen is shown on your PC. This is because the Guest is downloading a picture of
the device, called a Skin (read more about Skins later in this document).

Wiselo Remote Desktop Guest

”@) =nw Connection Help
o P2 BIUG G X

Remote File  Chat  Remote  Coldt Send Run  Execte  Disconnedt
. ‘

Desktop Transtes Management  Inventory Metiage Program Commans
Session Command Adion

Remote Control Comectto
gt Soemeany Host D (Computer name or 1P address):
Q Alcmmacton = e
5 Phane ool
4 3 Hote A
Contiguraten
3 Program opton:
D Userintertace
o Session
b s
¥ Remote Desktop =
@ Mobile Skons. ot o8 0%)
EYS p——

Control screen y

kin buttops
P —

Now you can remote control the device, that is, you can inject keystrokes on the remote
device, view how the screen of the remote device changes and use the various other
features, such as file transfer, hardware / software inventory, chat, remote clipboard etc.
When using transparent skin as in the example above, you can right click on the skin to

access the menu options
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3. Skins

By default on a Windows PC / Browser, the desktop of the Windows Mobile/CE device will be shown

inside a picture of the device. This picture of the device
is called a Skin.

The device buttons seen on the Skin (with some
exceptions) are “live” and can be used to control the
device, as if they had been pressed locally on the device.

WiseMo products are made to help eliminate distance by
creating a feeling of being there. Using WiseMo's
advanced Skin technology greatly improves this feeling
of “being there”. Besides using the mouse directly on the
Skin, the Guest keyboard can also be used to execute
keystrokes on the Host device.

The Skin functionality can be controlled from “Connection
Properties” for the Host and from the Configuration pane,
both found in the Guest module.

A skin is as default shown inside a
window. The window provides you with
menu options and status information at
the bottom. Notice you can detach the
menu bar; it may contain more options
than can be shown on a narrow window.

It is possible to show the device without
the window (use transparent window).
You define this prior to connection, via
the Connection Properties settings.
When a transparent window is used,

Skin in a window

/4| wiseMotost | @s x 505 X

<guListening profiles: TCP, UDP

Home B Menu

The Skin
3 Live

Calendar . Contacts ‘ screen

' @ mororoa
o "'
i e Multiple
D’Q . buttons
L K2 N

Transparent skin

point the mouse on the device skin and right-click to access menu options.

<a Home A Skin for a device is automatically chosen based
O symboiz0 on the “Device ID".

W+ SYMBOL MCO090K

— Language: ENU The “Device ID” for a particular device can be

T a0l seen in the Host's Info screen. In this example,
@ myCoud "WiseMo Dema” oniine the Device ID is called SYMBOL MC9090K

WiseMo has created Skins for many devices. If a
Skin doesn’t exist in the Skin repository, a default
Skin will be shown.

You can also setup the system to not use a Skin, but just display the “desktop” of the device.

If you like support for a specific skin, you are welcome to contact us, please email
info@wisemo.com Please include the Device ID, found on the Status screen of the Host.

For customers who would want to create a Skin for their own device, WiseMo provides a Skin
Designer. The Skin Designer is free of charge and the only requirement is that the Skin creator
donates the Skin to WiseMo for the benefit of all other users. If you are interested in creating your

own Skins, please contact us at info@wisemo.com
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4. Host Configuration Manager

The configuration settings for the Host are stored in the host.xml file, typically found in the

\WiseMo Host\ directory on the device.

Due to the abundance of different configuration
options available, WiseMo has created a Host
Configuration Manager program, which makes it easy
to configure Host settings via a Windows PC.

The Host Configuration Manager, also termed Mobile
Host Manager, is installed on your PC desktop
computer when running the Windows Installer (.MSI)
package for the Host. You can also download it
separately here. If your Windows PC has the WiseMo
Windows Host module installed, this Host will also act
as Configuration Manager for the Windows Mobile/CE
Host, when you connect your device to the PC.

When installed, the Host Configuration Manager is
found in Start > All Programs > WiseMo RSM >
Mobile Host Manager (or WiseMo Host Manager).

Connect your device(s) to the PC and the Host

iy
_/J Home Maobile Help

Load Store || Refresh
Device Taol

SYMBOL_MC9090K

Configuration
[£% Program Options
Lz Program cptions
F: Host Name
&4 Share my Device
Ji4 Help Request
8 Security
45 Guest Access Privileges
& Guest Policy
2% Encryption
% Address filtering
<95 Communication Profiles
[E% Log Setup
4 File Log

‘ Desktop computer

é‘ !7 SYMBOL_MC9I090K

é !? Samsung Galaxy 54

WiseMo Host Manager - Mobile Cc

Maming
@ Use Device ID
_) Use Bluetooth/Device name (Android)
) Use IMEI/Device serial number (Android)

_) Enter name (optional)

m

Mame options
Public Host ID

Manager will automatically detect the devices. If not, press the Refresh button. Select the
appropriate device and the program will retrieve the Host configuration file that’s already on this

device.

|:| Windows Portable Device

[C] android ADB

Windows CE Remote AFL
Maobile Detection Methods |

Make sure that the appropriate methods are enabled for detecting
the device. You do this from the Host Manager’s Home tab.

In case a device cannot connect to a Windows PC for configuration

If it is not possible for the WiseMo Host Configuration Manager to detect the device or if the
device cannot be connected to a PC, then the WiseMo Host Configuration Manager cannot load
and upload a configuration file directly from the device. This may for example be the case for

some Windows Compact Embedded devices.

In that case, an existing Host.xml configuration file, for example already on the device, could
be copied to a desktop PC and then opened by the Configuration Manager (File > Open).
When all required configuration changes have been made, the configuration has to be saved
on the desktop PC (File > Save). Next the modified configuration file has to be copied back to
the device again to the relevant path and the Host program has to be restarted.

The Configuration file is normally found here: \WiseMo Host\host.xml

The Configuration Manager offers a Wizard to take you
through the most important settings.

You can select it from the Home tab, if it does not

automatically load, when you connect the device to your PC.

The wizard helps you to configure various settings, for
example start-up settings and authentication as well as
authorization options.

TIP: To configure the Windows Mobile/CE Host to use
myCloud, the easiest method is by running the Wizard.

Configuration Wizard - symbol-c3080

uide you through the selection of certain
to make the WiseMo module ready for use.

Instead of using the Wizard to configure your preferred settings, you can go directly to the

configuration panel and make the changes you need.
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The configuration panel in the Host Manager includes a number of configuration options, the most
important probably being Guest Access Security, which controls authentication (who) and
authorization (what) settings.

Select the Configuration item you like to change and the program will list the various settings
available, which are then easily changed.

Remember to click the Apply button to keep any change you have made to a specific configuration
item. When done with your changes, save the new configuration to the device by pressing the
Store button.

Please note that the Host app on the device has to be restarted in order to load and use the new
configuration.

Example: Guest Access Privileges, settings that controls who may do what.

T WiseMo Host Manager - Mobile Configuration -8

ey

_/ Home Maobile Help Style - @)
g9 @
Load Store Refresh
Device Tool

SYMBOLS0
Configuration
@ Program Options
J Program options
[ Host Name
i‘j Share my Device
d Help Request

. X
1 The configuration changes are not stored to the device, Click the Store button i.. ‘

Guest Access Authentication Method

[User name and password V]

Individual Guest access privileges based on user name and password

& Security [ Full access o Allow guest to: -
4o Guest Access Privileges i ®  Test Guest Remote desktop
& Guest Poli . Use keyboard and mouse
uest Policy [ View only 7] Lock keyboard and
%’ Encrvption ock keyboard and mouse
7 newr (3 Tnventory only Blank the screen
B Addre.ss fl.lterlng ) [ Remote Management only [¥] Transfer dipboard
‘ib_; Communication Profiles [ Execute command (Restart, ...)
L:sz Log Setup Request chat
E% File Log Send files to host
Receive files from host |
Run programs =
Remote Manage
Retrieve Inventory
Send Message

Join multi Guest session
Act as multi Guest session Administrato
“F Confirm access:

a_.
Add Security Role () Yes, except when
' Desktop computer [ Delete ] [ Add Guest ] -
@ SYMBOL30
» [ Apply ] [ Cancel
¥ 1024017 *

Here you define which Guest Authentication method to use, and what an authenticated Guest user
is authorized to do. You may want to define the use of Confirm Access, for attended devices,
where you want the user on the device to provide permission before a remote Guest user gains
access. For un-attended devices, you will want to define user ID / password credentials, so only
authorized Guest users can gain access. You can

also add your own security roles that govern what | W=eMoRSM- Configuration Wizard i
authenticated users can do, or apply one of the myCloud .

. . . Do you want to configure your myCloud log on settings? p \I\“\)
predefined roles. For example, if you only permit —
Inventory collection, simply apply the Guest user @ no
to the “Inventory only” role. e e s

. = @ Yes, configure myCloud log on settings

Example. Preparlng the HOSt for mYCIOUd Select yes if you want to pre-configure myCloud log on settings. myCloud enables you to
con nectivity seamlessly connect to Host modules over the Internet.
If the Host modulg was not deplo_yed fr.om your e
myCloud domain, its default configuration may not o S
contain settings to connect it to your myCloud Leam shout myCloud

domain. It is strongly recommended to use the
Configuration Wizard to configure the Host to
connect to your myCloud domain ! ! <gae [ redz | [ conce
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= To configure for myCloud from the Host Configuration Manager on your PC, select the
f Wizard button on the Home tab. Click next until you reach the myCloud screen, then
select Yes, and press next.

Wizard
configuration]  ENter your myCloud user account credentials (email and password) and click next until

= the wizard has finished. Remember to store the new settings to your device (from the
Mobile tab) and re-start the Host module on your device.

Manually preparing via Configuration Manager (only for very advanced usage)

From the Host Configuration Manager, it is strongly recommended to use the Wizard to configure
the Host to use myCloud.

For advanced usage, you can also define€ @  communication Profile Edit by
myCloud communication profile via the — _
Conﬁ Uration ane. Communication Information

g p Description of Communication Profile:
Select Communication Profiles. If the myCloud e
myCloud profile exists, press Edit. Communication Device:
Otherwise select New to create a myCloud (ovdod -]
profile. myCloud

. . . myCloud Service URL: ILI
Make sure that the communication profile httpsfmycloud.nisemo.com/an
has settings as shown on the screen shot:
| Optimize for Internet communication

Press the Test button to verify your Advanced ...
settings are correct.

Then press the Credentials... button, and enter the credentials for the myCloud domain:

myCloud Service Credentials

Notice, myCloud domain Service Credentials is

NOT the same as your myCloud User account Credentials
credentials (email and password)! e
Cancel
Password:
You can find the myCloud domain Service Confirm password:
Credentials in your myCloud domain, under the
Settings tab / Connection option. E:E_mainn;mﬁ —
Jieshsss
myCloud domain Service Credentials
Account name: - Normally enter into the Account name field the word: DefaultConnection
Password: - Enter the myCloud Domain password
Domain name: - Enter the myCloud Domain name

Press the Test button to verify the credentials.

Remember to press the Apply button and to Store the changes to the device and re-start the Host.
Now the Host should appear in the Guests list of myCloud enabled Hosts.

Removing the Host Configuration Manager

You can remove the Mobile Host Manager on the Windows PC by using “Add or Remove
Programs/Program and Features” from the Windows Control Panel or you can use the Remove
functionality in the installation MSI package.

IF you have any questions regarding the Host Configuration Manager please feel free to contact us
- we are here to assist you and welcome your questions. Please email your question to
support@wisemo.com Thank you!
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5. License information for the Host program

The Host program, version 17, can be licensed in various ways.

myCloud licensing (subscription)

Requires that the Host is logged on to a myCloud domain, so the Host must be able to
communicate via the Internet. A Guest user can use myCloud connectivity, as well as direct TCP/IP
connectivity to reach the Host.

Use myCloud licensing if you need to reach the Host via the Internet, or if you prefer the
subscription based payment model for direct TCP/IP connectivity between the Guest and Host.

You can apply a perpetual license key to a myCloud licensed Host. This will switch it’s licensing into
a perpetual license for TCP/IP connectivity. It can still connect via myCloud as long as it is logged
into a myCloud domain (which still consumes a myCloud license).

Perpetual licensing (one-time fee)

Requires that a license key is applied to the Host. A Guest user can use TCP/IP connectivity to
reach the Host. It is also possible to log the Host onto a myCloud domain for myCloud connectivity
(consumes a myCloud license).

Use perpetual licensing if you need to reach the Host directly via TCP/IP and Internet is not
available or if you do not want to depend on the availability of the Internet.

Trial license

If not deployed from a myCloud domain, you may have been prompted to enter a license key
during installation. If a trial key is entered, the Host will run for a limited time only (you can
request a trial license key here)

You can switch the Host trial to myCloud licensing, by deploying the Host from a myCloud domain.
Alternatively, you can purchase a license key for a perpetual license.

6. Updating or removing the Windows Mobile / CE module

A newer version or service release of the Host application can be installed on top of the previous
one. Updating an existing installation will as default preserve configuration settings, which are
found in the Host.xml file in the folder \WiseMo Host. You can delete this file prior to installation, if
you want to start with default configuration settings.

Exception: If you install via a myCloud deployment link, for example sent via SMS, email or other
methods, the Host will always be enabled for this specific domain. Furthermore, if a configuration
file has been added to the deployment link, this configuration file is always used, replacing any
existing configuration file on the device. This allows for deployment of configuration settings via
the use of myCloud deployment links.

Removal of the WiseMo Host application from a Windows Mobile/CE device is done like you would
remove any other program. For example from the device’s Settings | System | Remove programs.
Select the Host module, and click the "Remove” button.
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7. Glossary

Computer - Any Server, Workstation, Desktop, Laptop that runs an operating system supported
by the Guest or Host module.

Device - Any Smartphone, Tablet, Set-top box, Scanner, or other handheld or un-attended device
that runs an operating system supported by the Guest or Host module.

Guest - the module installed on a computer or device, e.g. PC, on an iPad, iPhone, Android device
or running from a supported Browser. From the Guest module, a user may remote control another
device or computer where the Host module is running.

Host - the module installed on the target computer or device that should be remotely controlled
from the Guest module. It can for example be a PC, Mac, Smartphone, Tablet, Set-top box, or any
other type of device that runs a supported operating system.

Host Configuration Manager - also termed Mobile Host Manager. A tool used for configuring a
WiseMo Host application. It is installed on a Windows desktop computer and communicates with
your device when the device is USB connected to your PC.

Skin - the graphical user interface for remote control of devices. Usually it is almost an exact
graphical copy of the real device which is being remote controlled. Skin buttons are “alive” and
imitate the keystroke of the real button: if you click on one of them then the same action will be
performed on the device as if you click the real button.

Communication profile - protocol configuration for the communication between a Guest module
and a Host module. There are two main communication methods: TCP/IP and myCloud. Before
connecting from a Guest to a Host you should specify on the Guest which communication profile
should be used.

myCloud - one of the communication profiles. myCloud communication is an internet based
protocol that allows connection through firewalls, proxies and NAT’ed networks. It comes as part of
WiseMo’s myCloud subscription based service for easy remote control connectivity between
computers and devices.
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